Сучасні технології програмування  (С#)

Лабораторная работа  1

Тема: Введение в C#. Пространство имен. Типы даних. Переменные и  константы. Консольный ввод-вывод. Выражения и операторы. (4 часа)

Цель: научиться создавать проекты на ЯП C#.
Теоретические сведения

Введение. 

Итак, начиная с этого момента, мы приступаем к изучению нового для вас языка программирования - С#(читается как “Си Шарп”). Безусловно, сразу возникает вопрос, а зачем нам нужен ещё один язык программирования, ведь до этого момента мы замечательно жили и без него, обходясь средствами уже изученных технологий? Каждый язык программирования имеет свои сильные и слабые стороны. Один язык предназначен для решения математических задач, другой для программирования микроконтроллеров в балалайках. Вы вряд ли будете пользоваться “балалаечным языком” для реализации сложного математического алгоритма. Безусловно, вы выберете тот язык, который максимально подходит для поставленную задачу. С# - это язык “настоящего и будущего”. Он вобрал в себя богатое наследие С/С++. При этом в него добавлено ещё много свойств, которые отсутствуют в родителях. Он упрощает программирование, экономя время программиста, не урезая функциональных возможностей языка, позволяет создавать надежные, устойчивые И разноплановые программы. Для того чтобы полностью понять плюсы C# необходимо рассмотреть среду .NET Framework, в которой функционируют программы, написанные на C#. Так что самое время перейти ко втором пункту нашего повествования Великому и Ужасному .NET Framework. 

На протяжении данного курса C# будет рассматриваться в контексте уже изученного вами языка программирования С++, т. е. детальному рассмотрению будут подвергаться лишь те аспекты C#, которые отличаются от уже известного вам материала. Если в практическом примере встречается неописанная в уроке конструкция, то это означает, что подобная конструкция существует в языке C++. При наличии "тонких" моментов в использовании конструкций, они будут описаны в текущем уроке или в ближайших уроках.
Среда .NET RunTime. Библиотека Framework – краткое описание. 
Рассмотрение интересующего нас вопроса начнем с понятия Microsoft .NET . C Официального сайта Microsoft: 
Концепция Microsoft .NET — целостный взгляд на новую эпоху в развитии информационных систем и Интернета, когда самые разнообразные программные приложения доставляются пользователям как сервисы, взаимодействуют между собой в соответствии с конкретными потребностями бизнеса, доступны на самых разных устройствах от высокопроизводительного кластера до мобильного телефона, имеют понятный и полностью адаптирующийся к потребностям каждого пользователя интерфейс. Microsoft .NET — закономерный этап в развитии информационных технологий, приложений и сервисов, позволяющий предприятиям воспользоваться преимуществами сочетания открытых стандартов и эффективной архитектуры Windows 2000. Microsoft .NET включает: 

1. Систему .NET Framework и инструментальные средства Visual Studio .NET — средства, инструменты, спецификации и информационные материалы для построения и сопровождения гибких, надежных и масштабируемых деловых приложений, использующих интернет/интранет/экстранет для взаимодействия с коллегами, клиентами и партнерами, обладающих привычными и понятными интерфейсами, способных работать с самыми различными устройствами. Используя Visual Studio.NET и Visual Studio for Applications, опираясь на .NET Framework и Windows .NET, можно самые сложные задачи решать быстрее, надежнее и эффективнее, чем когда-либо в прошлом. 
2. Семейство корпоративных .NET серверов — современная линейка корпоративных серверов, созданная, чтобы облегчить использование и интеграцию самого широкого круга деловых сервисов на основе веб-стандартов и технологий. Реализует самые современные представления об архитектуре информационных систем. Отвечает самым взыскательным запросам в области масштабирования, производительности, надежности и безопастности, удобства разработки и эксплуатации. 

3. Службы .NET — Building Block Services — типовые «строительные блоки», позволяющие архитекторам корпоративных и общедоступных информационных сервисов сосредоточиться на своих специфических проблемах, а для решения стандартных задач (авторизация, персонализация и другие) использовать стандартные решения. 

4. Программное обеспечение для устройств — позволяет использовать для доступа в интернет, связи с .NET-серверами и получения разнообразных услуг не только персональные компьютеры, но и сотовые телефоны и другие устройства. 

5. Разнообразные рабочие среды — на платформе .NET реализованы рабочие среды, являющиеся наиболее естественными и удобными для основных категорий пользователей: информационные службы и сервисы MSN для самого широкого круга потребителей; интегрированные деловые сервисы bCentral для предприятий малого и среднего бизнеса; Office для работников компаний, учреждений и вообще для всех, кто создает и использует традиционные документы; Visual Studio .NET для профессиональных разработчиков.

Из этого официального заявления Microsoft можно сделать следующие выводы: 

1. Microsoft планирует связать существующие информационные технологии, тесно интегрировав их друг в друга. 

2. Без создания новых средств разработки Microsoft не смог бы продвигать такую перспективную идею, как Microsoft .NET

Нас как программистов, безусловно, волнует первый пункт концепции Microsoft .NET - .NET Framework. NET Framework – это часть Microsoft .NET, с помощью которой осуществляется разработка программного обеспечения. NET Framework состоит из Common Language Runtime(CLR) и набора библиотек классов .NET Framework, который также называют Base Class Library(BCL). CLR – это не зависящая от языка среда исполнения программ. Данная система исполняет программу, обеспечивает переносимость, поддерживает программирование с использованием нескольких языков, обеспечивает безопасность. Библиотека классов содержит в себе все необходимые средства для работы с современными технологиями. Все языки .NET могут обращаться к функциям .NET Framework Оцените насколько это выгодно из разных языков программирования, поддерживающих концепцию .NET, вы можете пользоваться одним и тем же набором функций !!! Любая программа, использующая библиотеку классов .NET может быть запущена только там, где поддерживается среда исполнения .NET. С# - это родной язык для платформы .NET, поэтому именно в нем реализованы все идеи .NET. 

Процесс компиляции С# - программы:

При компилировании C# - программы программист получает не исполняемый модуль, а файл, содержащий специальный псевдокод, называемый промежуточным языком Microsoft (Microsoft Intermediate Language или MSIL). MSIL определяет набор переносимых инструкций, не зависимых от конкретного процессора. Важно отметить, что расширения у получившегося файла с MSIL-кодом будет exe, что не должно вводить вас в заблуждение. Система СLR транслирует промежуточный код в исполняемый во время запуска программы. Любая программа, скомпилированная в MSIL – код, может быть запущена в любой операционной системе, для которой реализована среда CLR. Это одна из частей механизма с помощью, которого достигается переносимость программ. MSIL – код превращается в исполняемый при использовании JIT – компилятора (just in time). Процесс работает следующим образом: при попытке выполнения NET - программы система активизирует JIT – компилятор, который компилирует MSIL – код в команды процессора. Компиляция выполняется только для непосредственно вызываемых методов программы. Откомпилированный выполняемый код сохраняется на машине и перекомпилируется только в том случае, если изменяется исходный код. 

Управляемый и неуправляемый код

При написании программы на C# программист создаёт так называемый управляемый код, который исполняется под контролем независимой от языка среды исполнения CLR. Поскольку программа запускается под контролем CLR, управляемый код должен соответствовать определенным требованиям. Требования такие: компилятор должен создать MSIL - файл, предназначенный для CLR, а также использовать библиотеки .NET Framework. Альтернативой является неуправляемый код , который не выполняется CLR. До появления .NET Framework все Windows - программы использовали его. Сейчас эти два подхода могут работать вместе.
Создание проекта. 

Итак, приступим к созданию проекта... 

Для начала запустим VS2005. При этом, в зависимости от ваших настроек, у вас появится примерно такая картинка. [image: image1.png]Repostory | Fle | Bt View Test VsussWN ModelTods Took Window Community Help
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После создания "пустого" проекта, в него необходимо добавить файл (если вспомните, то в проектах C++ вы делали тоже самое). [image: image6.png]Repostory Fle Edt View | Proect | Bukl Debug Dats Test VsussW ModelTooks Took Window Communty Hep
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После выбора указанного на рисунке (выше) пункта меню, вы увидите окно, отображенное на следующем рисунке (следуйте ему). 
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Если вы все сделали "культурно", то можно начинать разбираться с самим программированием на C#. 
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Первое приложение. Анатомия программы. 

Настало время попробовать что-нибудь написать... Мы думаем, что никого не удивит, если первым приложением таки будет стандартный "Hello, World". Хотя попробуем немного подправить стандарты, а затем разберем из чего же состоит минимальное приложение на C#. 

<исходники> ..\Applications\Hello, World!!! 

// Пространство имен
namespace CSharpApplication.HelloWorld

{

   // Класс

   class FirstApplication

   {

      // Точка входа в программу

      static void Main()

      {

         // Вывод предложения на экран

         System.Console.WriteLine("Привет, C#!\n");

      }

   }

}

Начнем по порядку... 

Ключевое слово namespace создает пространство имен, в котором пользователь может создавать свои классы, не опасаясь совпадений имен. Например, если существуют 2 пространства имен A и B, то в каждом из них можно создать класс C. В этом случае ошибки о повторном объявлении класса возникать не будут, так как в разных пространствах имен классы друг друга "не видят". Подробнее пространства имен будет рассмотрены в последующих разделах. 

В языке C# отсутствуют глобальные переменные и функции, поэтому все объявления переменных и функций должны находиться внутри объявления класса (само собой количество классов неограничено). 

Точкой входа в приложение является функция Main (язык C# регистрозависимый, поэтому обратите внимание на заглавную букву M). Функция должна быть объявлена как статическая, так как в этом случае для вызова функции не требуется создавать объект класса. 

В языке C# нет заголовочных файлов. Большинство стандартных классов расположено в пространстве имен System, в частности, класс Console, содержащий функции для работы с консолью. О предназначении функции WriteLine можно догадаться с помощью буквального перевода: функция выводит информацию на экран, завершая вывод enter'ом. Подробности читайте в последующих разделах. 

Пространство имен C#. 

Вступление. 

Предположим, что вы принимаете участие в некотором проекте, и в вашей команде три человека. После того как каждый участник закончил свою часть проекта, настало время собрать все написанные модули для компоновки. Вот здесь и могут возникнуть проблемы, связанные с названиями классов. Если названия классов совпадают в разных модулях, то при их компоновке в единое целое возникают ошибки, с которыми далеко не всегда можно быстро справиться. 

Вот тут вам могут помочь пространства имен. Если проводить аналогии, то пространство имен можно сравнить с капсулой, в которой хранится ваш код. Например, если в предыдущем разделе поменять имя нашего класса на Console (вместо FirstApplication), то конфликтов не будет, так как стандартный класс Console "спрятан" внутри пространства имен System. То есть, исользуя пространства имен, вы можете избегать досадных ситуаций, связанных с использованием классов от других разработчиков. 

Теперь пора узнать как же "готовить" пространства имен :). 

В качестве имени пространства имен может служить любой допустимый идентификатор, имя также может содержать точки. 

namespace A

{

   // Код
}

namespace A.B

{

   // Код

}

Пространства имен могут содержать внутри себя следующие объявления: 

· вложенные пространства имен 

· namespace A

· {

·    // Код

·    namespace B

·    {

·         class Test

·         {

·            public static void f()

·            {

·                System.Console.WriteLine("Test");

·            }

·         }

·    }

· }

· namespace C

· {

·     class Test

·     {

·         static void Main()

·         {

·            A.B.Test.f(); // Вызов

·         }

·     }    

· }

· классы 

· структуры 

· интерфейсы 

· перечисления (enum) 

· делегаты 

Последние четыре элемента будут рассмотрены в последующих уроках. 

Также предусмотрена возможность добавлять в пространства имен элементы "на ходу". 

namespace A

{

   class T1

   {

       // Код
   }

}

namespace B

{

   // Код
}

namespace A

{

   class T2

   {

       // Код

   }

}

В приведенном выше примере класс T2 добавлен в пространство имен A после объявления самого пространства имен. 

Надеемся, вы понимаете, что создавать имена, подобные A или B, смысла немного. А если создавать понятные любому пользователю имена, то обращение к классам окажется слишком громоздким. Для выхода из подобных ситуаций служит директива using. Используя директиву using, вы можете переносить содержимое пространства имен в данную точку программы. Таким образом вы избавляетесь от необходимости указывать пространство имен, в котором содержится требуемый вам код. 

using System;

namespace Test

{

   class Message

   {

      // Вместо System.Console.WriteLine("Test message");

      Console.WriteLine("Test message"); 

   }

}

<примечание> доступ к содержимому вложенных пространств имен (в данном случае пространства имен System) получен не будет. 

using System;

using A;
namespace A

{

   // Код
   namespace B

   {

        class Test

        {

           public static void f()

           {

               Console.WriteLine("Test");

           }

        }

   }

}

namespace C

{

    class MainClass

    {

        static void Main()

        {

           A.B.Test.f(); // Правильный вызов

           // B.Test.f(); // Неправильный вызов

           // Test.f(); // Неправильный вызов

        }

    }    

}

using System;

using A;

using A.B;
namespace A

{

   // Код
   namespace B

   {

        class Test

        {

           public static void f()

           {

               Console.WriteLine("Test");

           }

        }

   }

}

namespace C

{

    class MainClass

    {

        static void Main()

        {

           A.B.Test.f(); // Правильный вызов

           Test.f(); // Правильный вызов

        }

    }    

}

Кроме вышеописанного, директива using позволяет создавать псевдонимы для пространств имен.и классов, входящих в него. 

using System;

using AliasAB = A.B;

using AliasABTest = A.B.Test;
namespace A

{

   // Код
   namespace B

   {

        class Test

        {

           public static void f()

           {

               Console.WriteLine("Test");

           }

        }

   }

}

namespace C

{

    class MainClass

    {

        static void Main()

        {

           AliasAB.Test.f(); // Правильный вызов
           AliasABTest.f(); // Правильный вызов
        }

    }    

}

Заключение. 

Использовать собственные пространства имен вовсе не обязательно. Если вы не создаете свое пространство имен при написании кода, то код помещается в неименованное (или глобальное) пространство имен, которое существует в каждом файле. В этом случае код будет доступен из любого именнованного пространства имен. 

Элементы, описанные в пространстве имен (их список был приведен выше), не могут иметь модификаторов доступа private или protected.
Типы данных. 

В этом разделе мы поговорим о типах данных языка C#. Не скроем, что вы найдете здесь массу сюрпризов. Начнем с того, что все встроенные типы данных являются синонимами для соответствующих структур (в некоторых случаях классов), определенных в пространстве имен System. Это означает, что каждая объявленная вами переменная является объектом ссответствующей структуры или класса (подробнее о структурах и классах читайте в следующих уроках). Например, каждый числовой тип данных имеет поля MinValue и MaxValue, хранящие соответственно минимальное и максимальное возможные значения для данного типа (см. практические примеры в этом уроке). 

Представляем вашему вниманию таблицу, содержащую встроенные типы данных языка C# и соответствующие им структуры или классы пространства имен System. 

	C# тип 
	.NET Framework тип 
	Количество бит 
	Суффикс, используемый в литералах 
	Описание 

	bool 
	System.Boolean 
	8 
	- 
	Логический тип, может принимать только два значения: true и false 

	byte 
	System.Byte 
	8 
	- 
	Беззнаковый байт 

	sbyte 
	System.SByte 
	8 
	- 
	Знаковый байт 

	char 
	System.Char 
	16 
	- 
	Символ Unicode 

	decimal 
	System.Decimal 
	128 
	m, M 
	Десятичное число с фиксированной точностью 

	double 
	System.Double 
	64 
	d, D 
	Число с плавающей запятой 

	float 
	System.Single 
	32 
	f, F 
	Число с плавающей запятой 

	int 
	System.Int32 
	32 
	- 
	Целое знаковое число 

	uint 
	System.UInt32 
	32 
	u, U 
	Целое беззнаковое число 

	long 
	System.Int64 
	64 
	l, L 
	Целое знаковое число 

	ulong 
	System.UInt64 
	64 
	ul, uL, UL, Ul, lu, lU, LU, Lu 
	Целое беззнаковое число 

	object 
	System.Object 
	- 
	- 
	Базовый тип данных, все остальные типы являются производными от него 

	short 
	System.Int16 
	16 
	- 
	Целое знаковое число 

	ushort 
	System.UInt16 
	16 
	- 
	Целое беззнаковое число 

	string 
	System.String 
	- 
	- 
	Строка символов Unicode 


Из перечисленных имен System.Object и System.String являются классами, остальные структурами. Поэтому объекты типа string и object называются ссылочными типами, а остальные структурными. Ссылочные и структурные типы будут подробно рассмотрены в следующих уроках. В этом уроке мы всего лишь отметим основную разницу между ними. 

Объект ссылочного типа создается в куче, а объект структурного типа создается в стеке. В том случае, если структурный тип присваивается объекту типа object, в куче создается временный объект, иммитирующий поведение ссылочного. В этот временный объект копируются данные из структурного, а сам объект помечается специальной отметкой, чтобы система знала к какому типу он относится. Этот процесс называется упаковкой (boxing), обратный процесс называется распаковкой (unboxing). 

Кстати, в языке C# отсутствует понятие указателя :( . 
Приведение типов. 

Неявно приводить можно: 

	Тип данных 
	неявно приводится к 

	sbyte 
	short, int, long, float, double, decimal 

	byte 
	short, ushort, int, uint, long, ulong, float, double, decimal 

	short 
	int, long, float, double, decimal 

	ushort 
	int, uint, long, ulong, float, double, decimal 

	int 
	long, float, double, decimal 

	uint 
	long, ulong, float, double, decimal 

	long 
	float, double, decimal 

	ulong 
	float, double, decimal 

	char 
	ushort, int, uint, long, ulong, float, double, decimal 

	float 
	double 


Примечание.  Константы типа int можно присваивать переменным типов sbyte, byte, short, ushort, uint, или ulong, в случае, если они могут их "съесть". 

Явно приводить нужно: 

	Тип данных 
	явно приводится к 

	sbyte 
	byte, ushort, uint, ulong, char 

	byte 
	sbyte, char 

	short 
	sbyte, byte, ushort, uint, ulong, char 

	ushort 
	sbyte, byte, short, char 

	int 
	sbyte, byte, short, ushort, uint, ulong, char 

	uint 
	sbyte, byte, short, ushort, int, char 

	long 
	sbyte, byte, short, ushort, int, uint, ulong, char 

	ulong 
	sbyte, byte, short, ushort, int, uint, long, or char 

	char 
	sbyte, byte, short 

	float 
	sbyte, byte, short, ushort, int, uint, long, ulong, char, decimal 

	double 
	sbyte, byte, short, ushort, int, uint, long, ulong, char, float, decimal 

	decimal 
	sbyte, byte, short, ushort, int, uint, long, ulong, char, float, or double 


За более полной информацией можно, как всегда, обратиться в MSDN.
Программирование консольного ввода-вывода.
Класс System.Console содержит два метода для считывания данных и два для вывода данных. Легче всего понять их работу можно лишь внимательно разобрав практические примеры, приведенные в уроке. Тем не менее уделим этим методам минутку внимания. 

Этот метод предназначен для считывания из потока очередного символа и возврата его в вызывающую функцию. В случае отсутствия символов возвращается -1. 

public static int Read();

Этот метод предназначен для считывания из потока строки символов и возврата ее в вызывающую функцию. В случае отсутствия символов возвращается null. 

public static string ReadLine();

Эти перегруженные методы предназначены для вывода в поток строки символов. 

public static void Write(bool);

public static void Write(char);

public static void Write(char[]);

public static void Write(decimal);

public static void Write(double);

public static void Write(int);

public static void Write(long);

public static void Write(object);

public static void Write(float);

public static void Write(string);

public static void Write(uint);

public static void Write(ulong);

public static void Write(string, object);

public static void Write(string, params object[]);

public static void Write(char[], int, int);

public static void Write(string, object, object);

public static void Write(string, object, object, object);

Эти перегруженные методы предназначены для вывода в поток строки символов, завершая ее текущим терминатором (чаще всего Enter'ом). 

public static void WriteLine(bool);

public static void WriteLine(char);

public static void WriteLine(char[]);

public static void WriteLine(decimal);

public static void WriteLine(double);

public static void WriteLine(int);

public static void WriteLine(long);

public static void WriteLine(object);

public static void WriteLine(float);

public static void WriteLine(string);

public static void WriteLine(uint);

public static void WriteLine(ulong);

public static void WriteLine(string, object);

public static void WriteLine(string, params object[]);

public static void WriteLine(char[], int, int);

public static void WriteLine(string, object, object);

public static void WriteLine(string, object, object, object);

Рассмотрим форматирование, применяемое в последних двух функциях: 

Например, Console.WriteLine("{0} + {1} = {2}", 2, 3, 2 + 3); выдаст на экран строку 

2 + 3 = 5

То есть, если вы хотите подставить в выводимую строку значения некоторых переменных, вы прописываете внутри строки в фигурных скобках порядковый номер элемента (отсчет ведется с нуля). 

Дополнительные возможность форматирования. 

Различные спецификации формата в применении к целому числу 1234567 (цифра после формата - это произвольное целое число, например, C0 или F6): 

	Тип форматирования 
	Код формата 
	Результат 

	Currency (денежные суммы) 
	C (способ применения {0:C}) 
	1 234 567,00 грн. 

	Currency (денежные суммы) 
	C1 (способ применения {0:C1}) 
	1 234 567,0 грн. 

	Currency (денежные суммы) 
	C8 (способ применения {0:C8}) 
	1 234 567,00000000 грн. 

	Decimal (десятичный) 
	D (способ применения {0:D}) 
	1234567 

	Decimal (десятичный) 
	D4 (способ применения {0:D4}) 
	1234567 

	Decimal (десятичный) 
	D8 (способ применения {0:D8}) 
	01234567 

	Exponential (экспоненциальный) 
	E (способ применения {0:E}) 
	1,234567E+006 

	Exponential (экспоненциальный) 
	E4 (способ применения {0:E4}) 
	1,2346E+006 

	Exponential (экспоненциальный) 
	E9 (способ применения {0:E9}) 
	1,234567000E+006 

	Fixed point (с фиксированной точкой) 
	F (способ применения {0:F}) 
	1234567,00 

	Fixed point (с фиксированной точкой) 
	F3 (способ применения {0:F3}) 
	1234567,000 

	General (общий) 
	G (способ применения {0:G}) 
	1234567 

	General (общий) 
	G2 (способ применения {0:G2}) 
	1,2E+06 

	General (общий) 
	G8 (способ применения {0:G8}) 
	1234567 

	Number (числовой) 
	N (способ применения {0:N}) 
	1 234 567,00 

	Number (числовой) 
	N0 (способ применения {0:N0}) 
	1 234 567 

	Number (числовой) 
	N8 (способ применения {0:N8}) 
	1 234 567,00000000 

	Percent (процент) 
	P (способ применения {0:P}) 
	123 456 700,00% 

	Percent (процент) 
	P1 (способ применения {0:P1}) 
	123 456 700,0% 

	Hexadecimal (шестнадцатеричный) 
	X (способ применения {0:X}) 
	12D687 

	Hexadecimal (шестнадцатеричный) 
	X5 (способ применения {0:X5}) 
	12D687 

	Hexadecimal (шестнадцатеричный) 
	X8 (способ применения {0:X8}) 
	0012D687 




В заключение необходимо отметить поведение функции ReadLine (подробности см. в последующих практических примерах): она считывает из потока строку символов. Следовательно, для получения необходимых данных, вам придется конвертировать полученную строку в соответствующий тип данных. Такое преобразование помогает осуществить класс System.Convert (см. примеры). 
Выражения и операторы. 

C# - это язык, который основывается на семействе "C"-подобных языков (С, C++, Java) поэтому многие его механизмы работают по схожему принципу, например, операторы. В С# существуют четыре основных класса операторов: арифметические, логические, операторы сравнения, побитовые, а также несколько дополнительных, которые используются для ряда специальных ситуаций. 

Арифметические операторы

	Оператор
	Значение

	+
	Сложение

	-
	Вычитание

	*
	Умножение

	/
	Деление

	%
	Остаток от деления

	++
	Инкремент

	--
	Декремент


Все перечисленные выше операторы, кроме % работают точно так же как в C/C++. В C# оператор деления по модулю может применяться как к целочисленным данным, так и к значениям с плавающей точкой. В С/С++ этого делать нельзя было. 

using System;

class Sample

{

   public static void Main() 

   {

      try{

          int a=5,b=2;

          double c = 19.67, d=3;

          Console.WriteLine("Результат {0}%{1}={2}",a,b,a%b);

          Console.WriteLine("Результат {0}%{1}={2}",c,d,c%d);

         }

      catch(Exception ex){

          Console.WriteLine(ex.Message);

         }

      Console.Read();

   }

}

Операторы сравнения

	Оператор
	Значение

	==
	Равно

	!=
	Не равно

	>
	Больше чем

	<
	Меньше чем

	>=
	Больше или равно

	<=
	Меньше или равно


Логические операторы

	Оператор
	Значение

	&
	И

	|
	Или

	^
	Исключающее или

	&&
	И (сокращенная схема)

	||
	Или (сокращенная схема)

	!
	Не


Результатом выполнения операторов сравнения и логических операторов являются значения типа bool(true/false).Например:

using System;

class Sample

{

   public static void Main() 

   {

      try{

          int a=2,b=3;

          if((a==2)&&(b==3)){Console.WriteLine("Это видно на экране 1 !!!");}


  if(a>31){Console.WriteLine("Это не видно на экране 2 !!!");}

          bool b1=false,b2=false;

          if(b1^b2){Console.WriteLine("Это не видно на экране 3 !!!");}

          b1=true;b2=false;

          if(b1^b2){

            Console.WriteLine("Это видно на экране 4 !!!");

          }

        }

        catch(Exception ex){Console.WriteLine(ex.Message);}

        Console.Read();

   }

}

Пример показанный ниже это ошибка на этапе компиляции, так как в С# невозможно неявное преобразование от int к bool. 



int a = 7;



if(a){ // Так нельзя в C#, а в С++ можно




Console.WriteLine("Ошибка !!!");



}

И Даже любимая логическая ошибка программистов на C++ для С# превратится в ошибку на этапе компиляции, по причине, указанной выше.

   int a = 7;

   if(a=8){ // В этой строке ошибка на этапе компиляции

      Console.WriteLine("Ошибка !!!");

   }

Данные особенности работы оператора условия будут подробно рассмотрены в следующем уроке.

Побитовые операторы

Как и в C/C++ они работают непосредственно с конкретными битами своих операндов.Операндами побитовых операторов могут быть только целочисленные значения.

	Оператор
	Значение

	&
	Побитовое И

	|
	Побитовое Или

	^
	Побитовое Исключающее Или

	~
	Побитовое Отрицание

	>>
	Побитовый сдвиг вправо

	<<
	Побитовый сдвиг влево


Они выполняют те же операции, что и их булевы логические эквиваленты.Отличие состоит в том, что побитовые операторы работают с операндами на уровне битов, впрочем это информация не должна являться для вас новостью, так как вы уже сталкивались с ними в C/С++. Давайте рассмотрим пример их использования:

using System;

class Sample

{

   public static void Main() 

   {

      try{

          int a = Convert.ToInt32(Console.ReadLine());



          // Проверка на четность

          if((a&1)==1)  Console.WriteLine("Нечетное значение");

          else Console.WriteLine("Четное значение");

          int b = 2,c=5;

          int f = b|c;

          // На Экране 7

          Console.WriteLine(f); 

          int kvadrat = b<<1;

          int kub = b<<2;

          Console.WriteLine("Квадрат "+b+" = "+kvadrat); 

          Console.WriteLine("Куб "+b+" = "+kub); 

         }

         catch(Exception ex){Console.WriteLine(ex.Message);}

         Console.Read();

   }

}

Операторы, переменные и литералы вместе образовывают выражения. Как и в С++ для улучшения читабельности программы выражения могут содержать символы табуляции и пробелы. Кроме того в выражениях можно использовать круглые скобки для повышения приоритета операторов внутри них.

Практический пример. Перевод секунд в дни, часы, минуты и секунды. 

Надеемся, что название примера говорит само за себя. Поэтому запускайте и разбирайтесь. 

<исходники> ..\Applications\ConvertSeconds 

using System;

namespace CSharpApplication.ConvertSecondsExample

{

   class ConvertSeconds

   {

      static void Main()

      {

         // Количество секунд в часе

         const ulong SecondsInDay = 60 * 60 * 24;

         ulong Seconds = 0;

         // Ожидаем корректного ввода
         while(Seconds == 0)

         {

            // Введите время в секундах в заданном диапазоне:

            Console.Write("Введите время в секундах ");

            Console.WriteLine("(от {0} до {1}):", 

               ulong.MinValue + 1, ulong.MaxValue);

            try
            {

               // Считываем введенное время и преобразуем его в ulong

               Seconds = Convert.ToUInt64(Console.ReadLine());

            }

            catch(Exception ex)

            {

               // Ошибка ввода
               Console.WriteLine(ex.Message + " Попробуйте снова!!!\n");

            }

         }

         // Вычисляем и выводим количество дней
         Console.WriteLine("Дней = {0}", Seconds / SecondsInDay); 

         // Отбрасываем дни

         Seconds %= SecondsInDay;

         // Вычисляем и выводим количество часов

         Console.WriteLine("Часов = {0}", Seconds / 3600); 

         // Отбрасываем часы

         Seconds %= 3600;

         // Вычисляем и выводим количество минут

         Console.WriteLine("Минут = {0}", Seconds / 60); 

         // Вычисляем и выводим количество секунд

         Console.WriteLine("Секунд = {0}", Seconds % 60); 

         // Ожидаем нажатия клавиши Enter

         Console.Write("\nНажмите Enter...");

         Console.Read();

      }

   }

}

Практический пример. Нахождение самой длинной неубывающей цепочки случайных чисел. 

Надеемся, что название примера говорит само за себя. Поэтому запускайте и разбирайтесь. 

<исходники>  ..\Applications\Sequence 

using System;

class Sequence{

   public static void Main(){


      int i=0,cur,max=1,curmax=1;

      int border;

      int prev;

      Console.WriteLine("Введите количество членов цепочки:");

      // Весь блок алгоритма заключаем в try/catch для перехвата исключений
      try{

          // Ввод количества элементов и перевод их в int

          border = Convert.ToInt32(Console.ReadLine());

          Console.WriteLine("Ваш выбор {0} элементов последовательности",border);



          // Создаём объект класса Random для генерации случайного числа

          // Начальная точка основывается на системном времени 

          Random rand = new Random();

          Console.WriteLine("Вот элементы последовательности:");

          // Генерируется случайное число от 0 до 100



          prev = rand.Next(0,100);

          Console.WriteLine("{0}",prev);

          do{

             // Генерируется случайное число от 0 до 100



             cur = rand.Next(0,100);

             if (cur>=prev)

                curmax++;

             else{

                if (curmax>max) 

                   max = curmax;

                curmax = 1;

             }

             prev = cur;

             Console.WriteLine("{0}",cur);

             i++;

            }while(i<border-1);

          if (curmax>max)

             max = curmax;

          // Показ полученного результата

          Console.WriteLine("\n\nМаксимальная Длина = {0}\n\n",max);

         }

         // Обработка исключительной ситуации

         catch(Exception ex){

            Console.WriteLine(ex.Message+" Не повезло !!!\n");

         }

         // Задержка перед выходом








         Console.Read();

   }

}

Практический пример.
 Перевод из десятичной дроби в простую.
<примечание> разделитель целой и дробной части числа зависит от локальных настроек операционной системы, поэтому, скорее всего, вам придется вводить дробное число через запятую (например, 1,56). 
<исходники> ..\Applications\Fraction 
using System;

namespace CSharpApplication.ConvertDecimalFractionToSimpleFraction

{

   class Fraction

   {

      static void Main()

      {

         // Ввод дроби
         Console.Write("Введите число: ");

         try

         {

            // Попытка преобразования введенной строки в decimal

            DecimalToSimpleFraction(Convert.ToDecimal(Console.ReadLine()));

         }

         catch(FormatException error)

         {

            // Вывод сообщения об ошибки
            Console.WriteLine(error.Message);

         }

         Console.WriteLine("Нажмите Enter...");

         Console.Read();

      }

      // Функция перевода
      static void DecimalToSimpleFraction(decimal Number)

      {

         // Сохранение знака числа

         int Sign = 1;

         if(Number < 0) 

         {

            Sign = -1;

            Number = -Number;

         }

         // Получение целой части числа

         int WholePart = (int)Number;

         // Получение дробной части числа

         decimal DoublePart = Number - WholePart;

         // Количество разрядов
         int Count = 0;

         // Пока дробное число не совпадет со своим целым эквивалентом

         while (DoublePart - (ulong)DoublePart != 0) 

         {

            // Считаем разряды
            DoublePart *= 10;

            ++Count;

         }


// Если дробная часть присутствовала

         if(Count > 0)

         {

            // Вычисление знаменателя
            decimal Denominator = Convert.ToDecimal(Math.Pow(10, Count));

            // Вычисление наибольшего общего делителя

            decimal N = NOD(DoublePart, Denominator);

            // Сокращаем дробь
            DoublePart /= N;

            Denominator /= N;

            // Вывод результата
            if(WholePart != 0)

               Console.WriteLine("{0}  {1} / {2}", 

                  WholePart * Sign, DoublePart, Denominator);

            else

               Console.WriteLine("{0} / {1}", 

                  DoublePart * Sign, Denominator);

         }

         // Если дробная часть отсутствовала
         else

            Console.WriteLine("{0}", WholePart * Sign);

      }

      // Функция, вычисляющая наибольший общий делитель
      static decimal NOD(decimal a, decimal b)

      {

         if(b == 0)

            return a;

         else

            return NOD(b, a % b);

      }

   }

}

Ход работы
1-й проект на C# 

1. Запустить Visual Studio 2005
 
ПУСК->Программы-> Visual Studio 2005-> Visual Studio 2005

2. Создать проект для приложения C#

File->New->Project->Visual  C#->Windows->Empty Project

3. Добавить в проект файл для ввода кода программы на С#

Project->Add New Item->Code File

4. Набрать код программы на языке С#
 using System; 

 class Example  { 

  
public static void Main() { 

    

Console.WriteLine("A simple C# program."); 

 
} 

}

5. Выполнить компиляцию,  построение и запуск приложения с паузой перед завершением
 
Debug->Start->Start Without Debugging (Ctrl+F5)

2-й проект на  С# (использование Solution)

1. Запустить Visual Studio 2005
 
ПУСК->Программы-> Visual Studio 2005-> Visual Studio 2005

2. Создать решение (Solution)  для  хранение множества проектов

File->New Project->Other  Project Types->Visual  Studio Solutions->Blank  Solution

3. Добавить в решение папку для хранения проекта

Пр. кнопка ->Add New Solutin Folder

4. В  этой папке создать проект для приложения на C#

Пр. кнопка->Add New Project…->Visual C#-> Windows->Empty Project

5. Добавить в проект файл для ввода кода программы

Пр. кнопка ->Add New Item->Code File

6. Набрать код программы на языке  C#
…

7. Выполнить компиляцию,  построение и запуск приложения с паузой перед завершением
 
Debug->Start->Start Without Debugging (Ctrl+F5)

8. Для работы со следующим проектом повторить пункты 3-7

9. Выбор  запуска нужного проекта  выполняется командой
 
Project ->Пр. кнопка ->Set  as  StartUp Project
Практическое задание C# 1-2 (4 ч.)
1. Какого типа переменные подойдут для хранения следующей информации:

Возраст человека
Население города

Число звезд в галактике

Один байт ОЗУ

Средняя зарплата за год

Сведения спортсмен или нет

Цвет фигуры

Длина в мм.


Длина в см.

Фамилия человека
Время года


Пол человека

2. Объявите и проинициализируйте переменные из п.1, дав им имена по смыслу. 
Выведите значения этих переменные на экран в форме  <Название: значение>, 
например :  Возраст человека: 25.
3. Объявите и распечатайте значения констант :
π=3,14;  e=-1,6x10-19;  текст со значением  Press <OK>;  символ со значеним табулятор.
4. Объявите переменные, необходимые для хранения следующих сведений о сотруднике : табельный номер (длинное целое), фамилия(текст), пол(символ),  возраст(короткое целое), вес(вещественное с одинарной точностью), курит или нет(булевское), тарифная ставка(вещественное с двойной точностью), должность(перечисление) и проинициализируйте их. Распечатайте данные на экране. Измените значения с помощью оператора присваивания и распечатайте их.  Введите данные о сотруднике с клавиатуры и  распечатайте их.  

5. В  классе приложения напишите открытый статический метод с параметрами для форматной распечатки сведений о сотруднике на экране. Вызовите его для распечатки  данных сотрудника.

6. *Измените программу 5. так, чтобы в ней обрабатывались сведения о двух сотрудниках.

Таблица 3-1. Встроенные типы языка C#

	Логический тип

	Имя типа
	Системный тип
	Значения
	Размер

	bool
	System.Boolean
	true, false
	8 бит

	Арифметические целочисленные типы

	Имя типа
	Системный тип
	Диапазон
	Размер

	sbyte
	System.SByte
	-128 – 128
	Знаковое, 8-бит

	byte
	System.Byte
	0 – 255
	Беззнаковое, 8-бит

	short
	System.Short
	-32768 –32767
	Знаковое, 16-бит

	ushort
	System.UShort
	0 – 65535
	Беззнаковое, 16-бит

	int
	System.Int32
	≈(-2*109 – 2*109)
	Знаковое, 32-бит

	uint
	System.UInt32
	≈(0 – 4*10)
	Беззнаковое, 32-бит

	long
	System.Int64
	≈(-9*1018 – 9*1018)
	Знаковое, 64-бит

	ulong
	System.UInt64 
	≈(0– 18*1018)
	Беззнаковое, 64-бит

	Арифметический тип с плавающей точкой

	Имя типа
	Системный тип
	Диапазон
	Точность

	float
	System.Single
	±1.5 × 10-45 ±3.4 × 1038
	7 цифр

	double
	System.Double
	±5.0 × 10-324 ±1.7 × 10308
	15-16 цифр

	Арифметический тип с фиксированной точкой

	Имя типа
	Системный тип
	Диапазон
	Точность

	decimal
	System.Decimal
	±1.0 × 10-28 ±7.9 × 1028
	28-29 значащих цифр

	Символьные типы

	Имя типа
	Системный тип
	Диапазон
	Точность

	char
	System.Char
	U+0000 – U+ffff
	16-бит Unicode символ

	string
	System.String
	Строка из символов Unicode

	Объектный тип

	Имя типа
	Системный тип
	Примечание

	object
	System.Object
	Прародитель всех встроенных и пользовательских типов


Примечание: 
При выполнении упражнения используйте локальные объявления в методе Main().
Дополнительное задание 

1. Ввести с клавиатуры число в диапазоне от 100 до 100000000 (введенное число проверяется). Подсчитать количество четных и нечетных цифр в этом числе в процентном отношении. 

2. Ввести с клавиатуры номер трамвайного билета (6-значное число) и проверить является ли данный билет счастливым. 

3. Ввести с клавиатуры дату своего рождения и текущую дату. Необходимо вычислить разницу в днях между этими датами. 

4. Вывести на консоль изображение государственного флага Швейцарии (например, в виде звездочек). Размер стороны флага задается случайным числом в диапазоне от 21 до 41. 

Контрольные вопросы
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